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ABSTRAK 
 
 

PENGGUNAAN  DEMNAS DAN PENGUKURAN TERESTRIS  
UNTUK PERENCANAAN JALAN  

( Studi Kasus :  Pelabuhan Tanah Merah Kcamatan Rawajitu Utara 
Kabupaten Mesuji ) 

 
Oleh 

 
Ridho Trianta Aji Putra 

 

Pelabuhan Tanah Merah adalah salah satu lokasi pelabuhan yang terdapat di 
Provinsi Lampung Kabupaten Mesuji terdapat jalan sepanjang akses 
sepanjang 7,3 km. Perencanaan Jalan Akses Pelabuhan Tanah Merah 
membutuhkan data yang baik dalam perencanaan geometrik jalan dan 
drainase jalan. Maka dari itu perlu data lain dari sumber data sekunder yang 
mendukung yang dapat digunakan untuk perencanaan jalan seperti data 
DEMNAS.  

Tahapan yang harus dilakukan mulai dari persiapan, pegumpulan data, 
pengukuran di lapangan, pengolahan data menggunakan software QGIS dan 
AutoCAD civil 3D 2013.  

Hasil pengolahan data DEMNAS pada lokasi Perencanaan Jalan Akses 
Pelabuhan Tanah Merah terdapat perbedaan elevasi yang cukup jauh 
dibandingkan dengan data hasil pengukuran terestris di lapangan. Selisih nilai 
elevasi pengukuran terestris dan DEMNAS memiliki hubungan yang tidak 
berbanding lurus dengan elevasi yang terukur. Perbedaan tinggi ini mungkin 
disebabkan karena tutupan lahan sehingga elevasi yang dihasilkan jauh 
berbeda. Elevasi yang dihasilkan dari data DEMNAS pada lokasi 
Perencanaan Jalan Askes Pelabuhan Tanah Merah memiliki ketinggian paling 
tinggi 4 Meter dan paling rendah 1 Meter sedangkan dari hasil pengukuran 
terestris dihasilkan ketinggian rata – rata 3 Meter. 

 

 
Kata Kunci : Jalan, Terestris, DEMNAS, QGIS, AutoCAD, Elevasi. 
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ABSTRACT 
 
 

USE OF DEMNAS AND TERESTRY 
FOR ROAD PLANNING 

(Case Study: Tanah Merah Harbor, Rawajitu Utara District, Mesuji District) 
 

By 
 

Ridho Trianta Aji Putra 
 

Tanah Merah Port is one of the port locations in Lampung Province, Mesuji 
Regency, there is a 7,3 km long access road. Planning of Tanah Merah Port 
Access Road requires good data in road geometric planning and road 
drainage. Therefore we need other data from supporting secondary data 
sources that can be used for road planning such as DEMNAS data.The steps 
that must be carried out start from preparation, data collection, field 
measurements, data processing using QGIS software and AutoCAD civil 3D 
2013.The results of DEMNAS data processing at the location of the Tanah 
Merah Port Access Road Planning location have a considerable difference in 
elevation compared to the data from terrestrial measurements in the field. The 
difference between the terrestrial and DEMNAS elevation values has a 
relationship that is not directly proportional to the measured elevation. This 
height difference may be due to land cover so that the resulting elevation is 
much different. The elevation generated from DEMNAS data at the Tanah 
Merah Harbor Askes Road Planning location has the highest height of 4 
meters and the lowest of 1 meter, while the results of terrestrial measurements 
yield an average height of 3 meters. 

Keywords: Road, Terrestrial, DEMNAS, QGIS, AutoCAD, Elevation. 
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MOTTO 
 

 

“Terkadang kita harus mundur satu atau dua langkah untuk bisa melompat lebih 
jauh”  

( R.T.A.P ) 

 

 “Hidup cuma sekali sudah itu mati, Gunakan waktu hidupmu sebaik mungkin” 

( R.T.A.P ) 

  
“Jangan mulai dari apa yang kita lihat, Tapi mulailah dari apa yang kita yakini” 

( R.T.A.P ) 
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I. PENDAHULUAN 
 

1.1 Latar Belakang 

Dalam kebutuhan perencanaan seringkali dibutuhkan model permukaan bumi 

yang merepresentasikan kondisi topografi yang sebenarnya. Model 

permukaan bumi ini banyak digunakan dalam berbagai bidang pada tahap 

perencanaan sampai tahap pemeliharaan. Dalam bidang konstruksi, model 

permukaan bumi ini digunakan untuk melakukan perencanaan bagaimana 

struktur bangunan akan dibangun berdasarkan topografi di lapangan. 

Seringkali kondisi topografi harus mengikuti desain dari perencanaan yang 

telah dibuat, sehingga perlu dilakukan rekayasa untuk mendapatkan hasil 

yang diinginkan, seperti melakukan perencanaan geometrik jalan, 

perencanaan drainase serta cut and fill. Hal tersebut dilakukan untuk 

membuang atau menambahkan permukaan tanah agar sesuai dengan desain 

perencanaan yang diinginkan. Akan menjadi penting mengetahui model 

permukaan bumi pada kawasan yang akan dibangun.  

Pelabuhan Tanah Merah adalah salah satu lokasi pelabuhan yang terdapat di 

Provinsi Lampung Kabupaten Mesuji terdapat jalan sepanjang akses 

sepanjang 7,3 km, pada kegiatan kali ini penulis melakukan kegiatan 

pengukuran topografi pada Jalan Akses Pelabuhan Tanah Merah dengan 

menggunakan alat Total Station dan data tersebut akan dibandingkan dengan 

data DEM. sebagai acuan apakah kedua data tersebut dapat digunakan 

sebagai salah satu bagian dari sistem perencanaan pembangunan jalan. 

Perencanaan Jalan Akses Pelabuhan Tanah Merah membutuhkan data yang 

baik dalam perencanaan geometrik jalan dan drainase jalan. Oleh karna itu 

diperlukan data sekunder yang untuk mendukung dalam perencanaan jalan. 
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Oleh karna itu penulis melakukan penelitian dengan tujuan untuk mengetahui 

efisiensi data DEM yang akan dibandingkan dengan data pengukuran terestris 

apakah dapat tersebut dapat digunakan dalam kegiatan Perencanaan Jalan 

Akses Pelabuhan Tanah Merah. 

1.2 Rumusan Masalah 

Berdasarkan latar belakang yang telah diuraikan penulis maka rumusan 

masalah yang didapat yaitu:  

1. Apakah data DEM (Digital Elevation Model) yang dibandingan dengan 

data pengukuran terestris dapat menjadi solusi sebagai data pendukung untuk 

keperluan Perencanaan Jalan Akses Pelabuhan Tanah Merah. 

1.3 Maksud dan Tujuan 

Adapun maksud dan tujuan tugas akhir sebagai berikut : 

1.  Melakukan pengukuran data terestris menggunakan Total Station dan       

Melakukan pengambilan data DEM dari website DEMNAS 

2. Membandingkan data hasil pengukuran Terestris dengan data  DEMNAS 

3. Sebagai sumber referensi  untuk keperluan penelitian yang berkaitan 

dengan perencanaan jalan. 

1.4 Batasan Masalah 

Batasan masalah dalam Tugas Akhir ini yaitu :  

1. Pengukuran Terestris Jalan Akses Pelabuhan Tanah Merah Kecamatan 

Rawajitu Utara Kabupaten Mesuji. 

2. Data yang digunakan dalam tugas akhir ini merupakan data pengukuran 

terestris dan DEMNAS. 

3. Perbandingan data hasil Pengukuran Terestris dan DEMNAS 

 

1.5 Lokasi Kegiatan 

Lokasi kegiatan  tugas akhir ini di desa Dipasena Kecamatan Rawajitu Timur 

Kabupaten Tulang Bawang Lampung. 
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Gambar 1. Peta Lokasi Penelitian (Sumber: Hasil Layout). 

 

1.6 Sistematika Penulisan 
Sistematika penulisan Laporan tugas akhir ini terdiri dari : 

1. Bab 1 pendahuluan yang membahas tentang latar belakang, maksud 

dan tujuan, batasan masalah dan lokasi kajian tugas akhir. 

2. Bab 2 menjelaskan teori dasar yang berhubungan dengan laporan tugas 

akhir. 

3. Bab 3 menjelaskan kegiatan yang dilakukan dalam tugas akhir. 

4. Bab 4 menjelaskan tentang hasil dan pembahasan. 

5. Bab 5 berisikan penutup dan kesimpulan dari hasil laporan tugas akhir. 

 

 

lokasi 



  

4 

 

 
 
 
 
 
 

II. TINJAUAN PUSTAKA 
 

2.1 Pengukuran  

Pengukuran merupakan kegiatan yang dilakukan untuk menentukan posisi 

(koordinat dan ketinggian) titik-titik dipermukaan bumi. Titik-titik yang 

diukur, dikelompokan kedalam dua kelompok yaitu titik-titik kerangka dasar 

dan titik-titik detail. Titik-titik kerangka dasar yang digunakan dalam 

keperluan pemetaan disebut kerangka dasar pemetaan. Pemetaan merupakan 

ilmu yang mempelajari kenampakan muka bumi yang menggunakan suatu 

alat dan menghasilkan informasi yang akurat. Pemetaan adalah suatu proses 

menyajikan informasi muka bumi yang berupa fakta, baik bentuk permukaan 

buminya maupun sumberdaya alamnya, berdasarkan skala peta, sistem 

proyeksi peta, serta simbol-simbol dari unsur muka bumi yang disajikan. 

2.1.1  Pengukuran Topografi 

Pengukuran Topografi adalah pengukuran yang bertujuan untuk 

mencari informasi permukaan tanah. Informasi tersebut dapat berupa 

tinggi rendah hingga keadaan fisik dan posisi suatu benda, baik yang 

berupa alamiah maupun buatan manusia, di permukaan lahan yang akan 

dipetakan. Kegunaan survei topografi adalah untuk mengumpulkan data 

yang diperlukan untuk pembuatan peta topografi. Sebuah topografi 

memperlihatkan karakter vegetasi dengan memakai tanda-tanda yang 

sama seperti halnya jarak horizontal diantara beberapa features dan 

elevasinya masing-masing di atas datum tertentu. Proses pemetaan 

topografi sendiri adalah proses pemetaan yang pengukurannya langsung 

dilakukan di permukaan bumi dengan peralatan survei terestris. Teknik 

pemetaan mengalami perkembangan sesuai dengan perkembangan ilmu 

dan teknologi. Dengan perkembangan peralatan ukur tanah secara 
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elektronis, maka proses pengukuran menjadi semakin cepat dengan 

tingkat ketelitian yang tinggi, dan dengan dukungan teknologi GIS 

maka langkah dan proses perhitungan menjadi semakin mudah dan 

cepat serta penggambarannya dapat dilakukan secara otomatis. 

2.1.2  Pengukuran Terestis 

Pengukuran Terestris merupakan kegiatan pengukuran yang dilakukan 

di permukaan bumi di mana pengamat melakukan kontak langsung 

dengan objek yang akan dipetakan. Pada dasarnya pengukuran survei 

terestris dilakukan untuk mendapatkan informasi posisi dari suatu objek 

di permukaan bumi. Metode pengukuran terestris mencakup 

pengumpulan data besaran arah, sudut, jarak, dan ketinggian yang 

diperoleh langsung dari lapangan. Survei terestris memiliki ketelitian 

informasi topografi (detil situasi, ketinggian/kontur, ukuran luas) yang 

cenderung tinggi apabila dibandingkan dengan teknik survei dan 

pemetaan lainnya. Untuk wilayah pemetaan yang tidak terlalu luas, 

survei terestris sangat efektif dilakukan. (KKNI-SKKNI IG, 2020.). 

 

2.2 DEMNAS 

DEM Nasional dibangun dari beberapa sumber data meliputi data IFSAR 

(resolusi 5m), TERRASAR-X (resolusi resampling 5m dari resolusi asli 5 

sampai dengan 10 m) dan ALOS PALSAR (resolusi 11,25 m), dengan 

menambahkan data mass point yang digunakan dalam pembuatan peta Rupa 

bumi Indonesia (RBI). Resolusi spasial DEMNAS adalah 0,27-arcsecond, 

dengan menggunakan datum vertikal EGM2008. (Badan Informasi 

Geospatial, 2019). 

2.3 DEM (Digital Elevation Model) 

Digital Elevation Model (DEM) merupakan bentuk penyajian ketinggian 

bumi secara digital. DEM terbentuk dari titik-titik sample yang memiliki nilai 

koordinat 3D (X, Y, Z). Titik sample merupakan titik-titik yang didapat dari 

hasil sampling permukaan bumi. Hasil sampling permukaan bumi didapatkan 

dari pengukuran atau pengambilan data ketinggian titik-titik yang dianggap 
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dapat mewakili relief permukaan bumi. Data sampling titik-titik tersebut 

kemudian diolah hingga didapat koordinat titik-titik sample. 

Jika titik-titik sample sangat padat, maka permukaan topografi akan 

didefinisikan secara mendalam. Jika titik-titik sample kurang padat, maka 

karakter-karakter medan yang penting dapat hilang. Contohnya, di area 

pengukuran terdapat bukit yang memiliki perbedaan tinggi dengan 

permukaan tanah disekitarnya, namun karena titik sample tidak diambil di 

bukit tersebut maka DEM yang dihasilkan menjadi rata dan bentuk bukit 

tidak tersaji dalam DEM tersebut. 

Permukaan tanah dalam DEM dimodelkan dengan membagi area menjadi 

bidang-bidang yang terhubung satu sama lain dimana bidang-bidang tersebut 

terbentuk oleh titik-titik pembentuk DEM. Titik-titik tersebut dapat berupa 

titik sample permukaan tanah atau hasil interpolasi dan ekstrapolasi titik-titik 

sample. (Aprilia, 2018). 

 

2.4 Jalan 

Jalan adalah prasarana transportasi darat yang meliputi segala bagian jalan, 

termasuk bangunan pelengkap dan perlengkapannya yang diperuntukan bagi 

lalu lintas, yang berada pada permukaan tanah, di atas permukaan tanah, di 

bawah permukaan tanah atau air, serta di atas permukaan air, kecuali jalan 

kereta api, dan jalan kabel (PP No.34 Tahun 2006). Menurut statusnya yaitu :  

1. Jalan Nasional adalah jalan yang menghubungkan provinsi (antar 

provinsi). Jalan nasional terdiri atas jalan arteri primer, jalan kolektor 

primer yang menghubungkan antar ibu kota provinsi, jalan tol, dan jalan 

strategis nasional. 

2. Jalan Provinsi adalah jalan yang menghubungkan antar kabupaten/kota 

dalam sebuah provinsi. Jalan provinsi terdiri atas jalan kolektor primer 

yang menghubungkan ibu kota provinsi dengan ibu kota kabupaten atau 

kota, jalan strategis provinsi, kecuali jalan arteri primer, jalan kolektor 
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primer yang menghubungkan antar ibu kota provinsi, jalan tol, dan jalan 

strategis nasional.  

3. Jalan Kabupaten adalah jalan yang menghubungkan antar kelurahan/ 

desa. Jalan kabupaten terdiri atas jalan kolektor primer yang tidak 

termasuk jalan nasional dan jalan, jalan lokal primer yang 

menghubungkan ibu kota kabupaten dengan ibu kota kecamatan, ibu 

kota kabupaten dengan pusat desa, antar ibu kota kecamatan, ibu   kota 

kecamatan  dengan desa, dan antar desa, jalan sekunder yang tidak 

termasuk jalan provinsi dan jalan sekunder dalam kota, dan jalan 

strategis kabupaten.  

4. Jalan Kota adalah jalan umum yang menghubungkan antar pusat 

pelayanan dalam kota, menghubungkan pusat pelayanan dengan persil, 

menghubungkan antara persil, serta menghubungkan antar pusat 

permukiman yang berada di dalam kota.  

5. Jalan Desa merupakan jalan umum yang menghubungkan kawasan 

dan/atau antar permukiman di dalam desa, serta jalan lingkungan.
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III. METODE TUGAS AKHIR 
 

 

3.1 Diagram Alir 

Dalam pelaksanaan kegiatan pembuatan tugas akhir mempunyai tahapan yang 

harus dilakukan mulai dari persiapan, pengumpulan data, pengukuran di 

lapangan, pengolahan data menggunakan software QGIS dan AutoCAD civil 

3D 2013, Berikut tahapan yang disajikan dalam bentuk diagram alir pada 

gambar 2.  
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Gambar 2. Diagram Alir. 
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3.2 Tahap Persiapan 

Sebelum melaksanakan Tugas Akhir ini terlebih dahulu dilakukan persiapan 

agar keberhasilan dalam pelaksanaan tugas akhir ini dapat tercapai dengan 

baik sebagaimana mestinya serta dapat meminimalisir kesalahan dalam 

pelaksanaannya, tahap persiapan tersebut adalah: 

3.2.1 Persiapan Administrasi 

Yang perlu dipersiapkan dalam persiapan administrasi adalah surat izin 

pelaksanaan Tugas Akhir (TA) yang di dapat dari Fakultas Teknik 

Universitas Lampung. 

3.2.2 Persiapan Alat dan Bahan 

Adapun peralatan dan bahan yang digunakan dalam pelaksanaan tugas 

akhir ini adalah sebagai berikut: 

a. Perangkat Keras (Hardware) 

1. 1 Unit Total Station 

2. 2 Unit Statip 

3. 2 Unit Jalon/Stik 

4. 2 Unit Prisma 

5. 1 Unit Laptop 

b. Perangkat Lunak (Software)   

1. Aplikasi QGIS untuk mengolah data DEM agar 

mendapatkan elevasi dari data DEM yang akan 

dibandingan dengan data pengukuran terestris. 

2. AutoCAD Civil 3D 2013 untuk mengolah dan 

menampilkan data hasil pengukuran terestris dan 

DEMNAS. 
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Adapun data yang digunakan dalam Tugas Akhir Ini adalah: 

c. Data Primer ‒ Data yang diukur langsung dengan survey, 

pengumpulan data lapangan yaitu berupa koordinat UTM 

dengan melakukan pengukuran Terestris menggunakan alat 

Total Station di Lokasi Jalan Akses Pelabuhan Tanah Merah.  

d. Data Sekunder ‒ Data yang didapat dari peta yang sudah ada, 

tabel-tabel atau sumber data yang lain. Data nya yaitu data 

DEM pada lokasi Jalan Akses Pelabuhan Tanah Merah 

dari website DEMNAS yaitu https://tanahair.indonesia.go.id/de

mnas.  

3.3 Tahap Pelaksanaan 

Dalam proses ini pengukuran dilakukan pada sepanjang jalur perencanaan 

pembangunan jalan akses ke pelabuhan tanah merah. Proses   pengukuran 

tersebut menggunakan alat Total Station. 

3.3.1 Pengukuran Terestris 

Pengukuran ini dilakukan dengan metode detail (situasi). Menyiapkan 

seluruh alat ukur yang akan digunakan untuk pengukuran. 

1. Setting alat ukur Seperti mendirikan statip, memasang tribach dan  

melakukan proses sentering. 

2. Membuat Job baru atau membuka Job lama pada TS.  

3. Memasukkan koordinat station point, koordinat stasion backsight 

point, tinggi alat, tinggi backsight, dan tinggi reflector (prisma) 

pada TS. 

4. Cek koordinat hasil bidikan backsight point  (selisih  antara 

koordinat bidikan dengan koordinat sebenarnya tidak boleh 

melebihi 10 mm). 

5. Pengambilan data dilakukan dengan cara membidik prisma sebagai 

target sasaran yang koordinat posisinya dicari. 

6. Setelah kegiatan pengambilan data selesai, copy/download Job data 

yang digunakan kedalam flashdisk/memory card. 

https://tanahair.indonesia.go.id/demnas
https://tanahair.indonesia.go.id/demnas
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3.4 Tahap Pengolahan  

Setelah melakukan pengukuran dan telah mendapatkan data koordinat UTM 

pada lokasi penelitian dan pengunduhan data pengukuran dari alat Total 

Station  tahap selanjutnya yaitu mengunduh Data DEM dan  mengolah data 

hingga menjadi file dengan format “txt” agar dapat dibandingkan dengan data 

pengukuran terestris menggunakan software AutoCAD Civil 3D 2013. 

 
3.4.1 Mengunduh Data DEM 

Tahap selanjutnya yaitu pengunduhan data DEM dari website 

DEMNAS yaitu https://tanahair.indonesia.go.id/demnas.  

1. Membuka website DEMNAS dan masuk ke menu Download. 

  

 

 

 

 

 

 

 

 
2. Selanjutnya yaitu melakukan pengunduhan data DEM sesuai dengan 

daerah yang dibutuhkan. 

 

 

 

 

 

 

 

Gambar 3. Website DEMNAS. 

Gambar 4. Pengunduhan Data DEM. 

https://tanahair.indonesia.go.id/demnas
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3.4.2 Pengolahan DEM Menggunakan QGIS 3.28 

Untuk mendapatkan elevasi dari DEM yang akan digunakan, Berikut 

pengolahan DEM menggunakan QGIS 3.28 

1. Buka aplikasi QGIS 3.28 kemudian pilih toolbox layer > add layer > 

add raster layer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Masukkan Data DEM yang sudah di download kemudian klik open.  

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 5. Tampilan New Project. 

Gambar 6. Tampilan Input Data. 
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3. Setelah Data DEM muncul di menu tampilan. selanjutnya ubah 

sistem koordinat DEM yang sebelumnya EPSG: 4326 menjadi UTM 

dengan cara klik kanan pada layer DEM > Export > Save As 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Kemudian pilih koordinat UTM sesuai dengan lokasi penelitian, 

tekan oke. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 7. Tampilan Mengubah Koordinat Menjadi UTM. 

Gambar 8. Memasukkan Sistem Koordinat UTM. 
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5. Setelah DEM diubah menjadi sistem koordinat UTM selanjutnya 

yaitu membuat boundary polygon area yang akan di ambil sampling 

elevasinya. Klik toolbox layer > create Layer > New Shapfile Layer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 9. Hasil DEM yang sudah diubah sistem koordinatnya menjadi 
UTM. 

Gambar 10. Tampilan membuat boundary polygon. 
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6. Selanjutnya melakukan sampling point dengan metode Regular 

Points. Klik Vector > Reserch Tools > Regular Points. 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Setelah melalukan sampling tahap selanjutnya yaitu memasukkan 

elevasi DEM ke atribut layer sampling points. Untuk memasukkan 

elevasi ( Z ) mengunakan plugin point sampling tool kemudian 

masukkan DEM yang telah di UTM kan sistem koordinatnya 

kemudian klik OK. 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 12. Tampilan memasukkan elevasi (z) ke atribut sampling 

points. 

Gambar 11. Hasil sampling points. 
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8. Selanjutnya yaitu memasukkan koordinat X dan Y ke atribut  

sampling points dengan cara klik kanan pada layer sampling points 

> Open Atribut table > Field Calculator > Masukan koordinat 

X,dan Y. 

 

 

 

 

 

 

 

 

 

 

9. Setelah memasukkan koordinat X,Y dan Z ke atribut sampling points 

selanjutnya yaitu melakukan export data sampling points menjadi 

CSV dengan cara klik kanan pada layer sampling points > export > 

Save Features As > masukkan format CSV > Beri nama file yang 

akan disimpan > OK. 

 

 

 

 

 

 

 

 

 

 

Gambar 13. Tampilan memasukan koordinat X dan Y. 

Gambar 14. Tampilan Export file menjadi CSV. 
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10. Selanjutnya yaitu data yang telah diubah menjadi CSV kemudian 

convert ke notepad menjadi file dengan format “txt”. Agar dapat di 

gunakan di software AutoCAD Civil 3D 2013. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 15. Tampilan file notepad dengan format txt. 
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3.4.3 Pengolahan Data Menggunakan AutoCAD Civil 3D 2013 

Untuk mengetahui hasil dari data yang telah di kumpulkan maka di 

butuhkan pengolahan data menggunakan AutoCAD Civil 3D 2013. 

Berikut langkah – langkah dalam pengolahan data menggunakan 

AutoCAD Civil 3D 2013 : 

1.  Buka aplikasi AutoCAD Civil 3D 2013 klik Create Point kemudian 

klik Import Point kemudian masukkan data pada menu Select File. 

Kemudian pada bagian Specify Point pilih format yang sesuai 

dengan file yang telah dimasukkan. Aktifkan ceklis pada Add 

Points to Point Group, kemudian beri nama dan klik OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 16. Menu Import point. 

Gambar 17. Tampilan Point Pengukuran. 
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2.  Membuat garis kontur dengan cara klik kanan pada Surface di 

bagian Toolspace, Kemudian pilih Create Surface selanjutnya beri 

nama kemudian tekan OK. 

 

 

 

 

 

 

 

 

 

 

 

 

3. Untuk menampilkan garis kontur klik kanan pada Point Group 

dibagian Definition > pilih Add  > Pilih All Points dan klik OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 18. Menu Create Surface. 

Gambar 19. Tampilan Kontur Data Pengukuran Terestris. 
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3.5 Tahap Penyajian 

Setelah proses pengolahan selesai tahap selanjutnya adalah penyajian data 

yaitu berupa data hasil pengukuran terestris dan hasil pengolahan DEMNAS 

yang kemudian akan dianalisis perbedaan hasil keduanya. 

Gambar 20. Tampilan Kontur Data Sampling DEMNAS. 
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V. KESIMPULAN DAN SARAN 
 
 
 

5.1 Kesimpulan 

Berdasarkan pembahasan di atas dan hasil dari pengolahan data pengukuran 

terestris dan pengolahan data DEMNAS maka dapat disimpulkan bahwa : 

1. Hasil pengolahan data DEMNAS pada lokasi Perencanaan Jalan Akses 

Pelabuhan Tanah Merah terdapat perbedaan elevasi dengan data hasil 

pengukuran terestris yaitu mencapai 1 sampai 2 Meter pada beberapa titik 

STA. 

2. Selisih nilai elevasi pengukuran terestris dan DEMNAS ini mungkin 

disebabkan karena keterbatasan dalam metode sampling yang 

menggunakan boundary polygon sehingga titik sampling yang di dapatkan 

melebihi batas titik ukur detail pada pengukuran terestris dilapangan. 

3. Elevasi yang dihasilkan dari data DEMNAS pada lokasi Perencanaan Jalan 

Askes Pelabuhan Tanah Merah memiliki ketinggian paling tinggi 4 Meter 

dan paling rendah 1 Meter sedangkan dari hasil pengukuran terestris 

dihasilkan ketinggian rata – rata 3 Meter. 

5.2 Saran 

1. Dari hasil analisa di atas dapat disarankan bahwa untuk penggunan data 

DEMNAS sebagai data pendukung dalam perencanaan sebaiknya 

digunakan pada area yang daerah tutupan lahannya tidak terlalu rapat 

atau pada area lahan terbuka agar data yang dihasilkan lebih maksimal 

sebagai data pendukung dalam perencanaan selain pengukuran terestris 

secara langsung di lapangan. 

2. Dan data DEMNAS lebih baik digunakan untuk skala besar 

dibandingkan untuk skala kecil. 
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